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I.     INTRODUCTION 

A function generator is usually a piece of electronic 

test equipment or software used to generate 

different types of electrical waveforms over a wide 

range of frequencies. Some of the most common 

waveforms produced by the function generator are 

the Sine wave , Square wave, Triangular wave and 

Sawtooth shapes. These waveforms can be either 

repetitive or single-shot (which requires an internal 

or external trigger source). Integrated circuits used 

to generate waveforms may also be described as 

function generator ICs. In addition to producing 

sine waves, function generators may typically 

produce other repetitive waveforms including 

Sawtooth and Triangular waveforms, square waves, 

and pulses. Another feature included on many 

function generators is the ability to add a DC offset. 

Although function generators cover both audio and 

RF frequencies, they are usually not suitable for 

applications that need low distortion or stable 

frequency signals. When those traits are required, 

other signal generators would be more appropriate. 

Some function generators can be phase-locked to an 

external signal source (which may be a frequency 

reference) or another function generator. Function 

generators are used in the Development, Test and 

Repair of electronic equipment. For example, they 

may be used as a signal source to test amplifiers or 

to introduce an error signal into a control loop. 

Function generators are primarily used for working 

with analog circuits, related pulse generators are 

primarily used for working with digital circuits. 

The voltage comparator multivibrator changes state 

at a predetermined maximum level, of the integrator 

output voltage. This change cuts-off the current 

supply from supply source 1 and switches to the 

supply source 2. The current supply source 2 

supplies a reverse current to the integrator so that its 

output drops linearly with time. When the output 
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Abstract: 
Waveform generators (also called function generators) are useful for testing and debugging circuits. In 

general we often use them to test the frequency response of electronics components like op amp and 

sensors.  This waveform generator is powered by an Arduino with Bluetooth control unit. The system 

can be controlled by pairing any Bluetooth enabled device with this generator. With the help of 

Application software in the device we can change the type of wave form, amplitude and brightness also. 

It outputs four wave shapes: sine, triangle, pulse, and saw, each wave shape ranges in frequency from 

1Hz-50kHz.  The frequency, pulse width, and overall amplitude (gain) of the waveforms is controlled 

by three potentiometers.  I've also included (optional) indicator LEDs that let you know which type of 

wave is currently being sent to the output. This type of low cost systems can be used in academic 

laboratories for the students to generate wave forms, observation and as input to some other system 

analysis. These low cost portable real time signal generators can replace the old traditional generators 

with high cost and maintenance. 
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attains a predetermined level, the voltage 

comparator again changes state and switches on to 

the current supply source. The output of the 

integrator is a triangular wave whose frequency 

depends on the current supplied by the constant 

current supply sources. The comparator output 

provides a square wave of the same frequency as 

output. The resistance diode network changes the 

slope of the triangular wave as its amplitude 

changes and produces a sinusoidal wave with less 

than 1% distortion. 

 

II.     HARDWARE DESIGN 

The Arduino Nano is a small, complete, and 

breadboard-friendly board based on the 

ATmega328 (Arduino Nano 3.0) or ATmega168 

(Arduino Nano 2.x). It has more or less the same 

functionality of the Arduino Duemilanove, but in a  

 
Fig 1: Arduino nano 

 

different package. It lacks only a DC power jack, 

and works with a Mini-B USB cable instead of a 

standard one. The Nano was designed and is being 

produced by Gravitech. 

The Arduino Nano is very much similar to the 

Arduino UNO. They use the same Processor 

(Atmega328p) and hence they both can share the 

same program. One big difference between both is 

the size UNO is twice as big as Nano and hence 

occupies more space on your project. Also Nano is 

breadboard friendly while Uno is not. To program a 

Uno you need Regular USB cable where as for 

Nano you will need a mini USB cable. There is a 

considerable amount of difference between the 

Arduino Nano and the Arduino mega as the 

processor used itself is different. Arduino Mega is 

more powerful than an Arduino Nano in terms of 

speed and number of I/O pins. As you might guess 

the size is also bigger than an Arduino UNO. 

Arduino Mega is normally used for projects which 

require a lot of I/O pins and different 

Communication protocols 

A  Input and Output 

Each of the 14 digital pins on the Nano can be 

used as an input or output, using pinMode(),  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig 2: Block Diagram 

 

digitalWrite(), and digitalRead() functions. They 

operate at 5 volts. Each pin can provide or receive a 

maximum of 40 mA and has an internal pull-up 

resistor (disconnected by default) of 20-50 kOhms. 

 

In addition, some pins have specialized functions: 

Serial: 0 (RX) and 1 (TX). Used to receive (RX) 

and transmit (TX) TTL serial data. These pins are 

connected to the corresponding pins of the FTDI 

USB-to-TTL Serial chip. External Interrupts: 2 and 

3. These pins can be configured to trigger an 

interrupt on a low value, a rising or falling edge, or 

a change in value. See the attachInterrupt() function 

for details. PWM: 3, 5, 6, 9, 10, and 11. Provide 8-

bit PWM output with the AnalogWrite() function. 

SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). 

These pins support SPI communication, which, 

although provided by the underlying hardware, is 

not currently included in the Arduino language. 

LED: 13. There is a built-in LED connected to 

digital pin 13. When the pin is HIGH value, the 
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LED is on, when the pin is LOW, it's off. The Nano 

has 8 analog inputs, each of which provide 10 bits 

of resolution (i.e. 1024 different values). By default 

they measure from ground to 5 volts, though is it 

possible to change the upper end of their range 

using the analogReference() function. Additionally, 

some pins have specialized functionality:I2C: 4 

(SDA) and 5 (SCL). Support I2C (TWI) 

communication using the Wire library  

Fig 3: Schematic of Arduino 
 

(documentation on the Wiring website).There are a 

couple of other pins on the board:AREF. Reference 

voltage for the analog inputs. Used with 

analogReference().Reset. Bring this line LOW to 

reset the microcontroller. Typically used to add a 

reset button to shields which block the one on the 

board. 

B Communication 

The Arduino Nano has a number of facilities for 

communicating with a computer, another Arduino, 

or other microcontrollers. The ATmega168 

andATmega328 provide UART TTL (5V) serial 

communication, which is available on digital pins 0 

(RX) and 1 (TX). An FTDI FT232RL on the board 

channels this serial communication over USB and 

the FTDI drivers (included with the Arduino 

software) provide a virtual com port to software on 

the computer. The Arduino software includes a 

serial monitor which allows simple textual data to 

be sent to and from the Arduino board. The RX and 

TX LEDs on the board will flash when data is being 

transmitted via the FTDI chip and USB connection 

to the computer (but not for serial communication 

on pins 0 and 1).A Software Serial library allows 

for serial communication on any of the Nano's 

digital pins. The ATmega168 and ATmega328 also 

support I2C (TWI) and SPI communication. 

 
C  Programming 

The Arduino Nano can be programmed with the 

Arduino software. Select "Arduino Diecimila, 

Duemilanove, or Nano w/ATmega168" or "Arduino 

Duemilanove or Nano w/ ATmega328" from the 

Tools > Board menu (according to the 

microcontroller on your board).The ATmega168 or 

ATmega328 on the Arduino Nano comes preburned 

with a bootloader that allows you to upload new 

code to it without the use of an external hardware 

programmer. It communicates using the original 

STK500 protocol (reference, C header files). You 

can also bypass the bootloader and program the 

microcontroller through the ICSP (In-Circuit Serial 

Programming) header. 

D Ad9833 Function Generator Module 

The AD9833 is a low power, programmable 

waveform generator capable of producing sine, 

triangular, and square wave outputs. Waveform 

generation is required in various types of sensing, 

actuation, and time domain reflectometry (TDR) 

applications. The output frequency and phase are 

software programmable, allowing easy tuning. No 

external components are needed. The frequency 

registers are 28 bits wide: with a 25 MHz clock 

rate, resolution of 0.1 Hz can be achieved; with a 1 

MHz clock rate, the AD9833 can be tuned to 0.004 

Hz resolution. The AD9833 is written to via a 3-

wire serial interface. This serial interface operates 

at clock rates up to 40 MHz and is compatible with 

DSP and microcontroller standards. The device 

operates with a power supply from 2.3 V to 5.5 V. 

The AD9833 has a power-down function (SLEEP). 

http://www.ijetjournal.org/
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This function allows sections of the device that are 

not being used to be powered down, thus 

minimizing the current consumption of the part. For 

example, the DAC can be powered down when a 

clock output is being generated. The AD9833 is 

available in a 10-lead MSOP package. 

 

 
 

Fig 4: AD9833 Module 

 
E  Circuit Description 

 

The AD9833 is a fully integrated direct digital 

synthesis (DDS) chip. The chip requires one 

reference clock, one low precision resistor, and 

decoupling capacitors to provide digitally created 

sine waves up to 12.5 MHz. In addition to the 

generation of this RF signal, the chip is fully 

capable of a broad range of simple and complex 

modulation schemes. These modulation schemes 

are fully implemented in the digital domain, 

allowing accurate and simple realization of 

complex modulation algorithms using DSP 

techniques. The internal circuitry of the AD9833 

consists of the following main sections: a 

numerically controlled oscillator (NCO), frequency 

and phase modulators, SIN ROM, a DAC, and a 

regulator. The AD9833 includes a high impedance, 

current source 10-bit DAC. The DAC receives the 

digital words from the SIN ROM and converts them 

into the corresponding analog voltages. The DAC is 

configured for single-ended operation. An external 

load resistor is not required because the device has 

a 200 Ω resistor on-board. The DAC generates an 

output voltage of typically 0.6 V p-p. VDD 

provides the power supply required for the analog 

section and the digital section of the AD9833. This 

supply can have a value of 

2.3 V to 5.5 V. The internal digital section of the 

AD9833 is operated at 2.5 V. An on- board 

regulator steps down the voltage applied at VDD to 

2.5 V. When the applied voltage at the VDD pin of 

the AD9833 is less than or equal to 2.7 V, the 

CAP/2.5V and VDD pins should be tied together, 

thus bypassing the on-board regulator. 

 

 
 

Fig 5: AD9833 Pin Description 

 
F  Bluetooth Hc05 Module 

 

HC‐05 module is an easy to use Bluetooth SPP 

(Serial Port Protocol) module, designed for 

transparent wireless serial connection setup. The 

HC-05 Bluetooth Module can be used in a Master 

or Slave configuration, making it a great solution 

for wireless   communication.   This   serial   port   

bluetooth   module   is    fully qualified Bluetooth 

V2.0+EDR (Enhanced Data Rate)3Mbps 

Modulation with complete 2.4GHz radio 

transceiver and baseband. It uses CSR Bluecore 

04‐External single chip Bluetooth system with 

CMOS technology and with AFH (Adaptive 

Frequency Hopping Feature). Bluetooth module 
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HC-05 is a MASTER/SLAVE module. By default 

the factory setting is SLAVE. The Role of the 

module (Master or Slave) can be configured only 

by AT COMMANDS. The slave modules cannot 

initiate a connection to another Bluetooth device, 

but can accept connections. Master module can 

initiate a connection to other devices. 

G  Pin Description 

 

The HC-05 Bluetooth Module has 6pins. They are 

as follows: 

 

ENABLE: When enable is pulled LOW, the module 

is disabled which means the module will not turn on 

and it fails to communicate. When enable is left 

open or connected to 3.3V, the module is 

enabled i.e., the module remains on 

and communication also takes place. Vcc: Supply 

Voltage 3.3V to 5V GND: Ground pin TXD & 

RXD: These two pins acts as an UART interface for 

communication STATE: It acts as a status indicator.  

Fig 6: Bluetooth Module 

 

When  the  module  is not   connected  to  /  paired 

with any other bluetooth device, signal goes Low. 

At this low state, the led flashes continuously which 

denotes that the module is not paired with other 

device. When this module is  connected to/paired 

with any other bluetooth device, the signal goes 

High. At this high state, the led blinks with a 

constant delay say for example 2s delay which 

indicates that the module is paired. BUTTON 

SWITCH: This is used to switch the module into 

AT command mode. To enable AT command 

mode, press the button switch for a second. With 

the help of AT commands, the user can change the 

parameters of this module but only when the 

module is not paired with any other BT device. If 

the module is connected to any other bluetooth 

device, it starts to communicate with that device 

and fails to work in AT command mode. 

 

 

 
 Fig 7: JST Connectors 

 

JST connectors are electrical connectors 

manufactured to the design standards originally 

developed by J.S.T. Mfg. Co. (Japan Solder less 

Terminal). JST manufactures numerous series 

(families) and pitches (pin-to-pin distance) of 

connectors. JST connectors are used in many types 

of products, and commonly used by  electronics  

hobbyists  and   consumer   products   for 

rechargeable   battery  packs, battery balancers, 

battery eliminator circuits, and radio controlled 

servos. The term "JST" is incorrectly used as a 

vernacular term meaning any small white electrical 

connector mounted on PCBs. A majority of JST 

through-hole headers can't withstand the 

temperatures required for reflow soldering, because 

the plastic has a lower melting point since they 

were designed for wave soldering methods. Some 

JST surface- mount headers are designed to handle 

higher temperatures of reflow soldering. A lithium-

ion battery or Li-ion battery (abbreviated as LIB) is 

a type of rechargeable battery in which lithium ions 

move from the negative electrode to the positive 

electrode  during   discharge   and   back   when   

charging.   Li-ion   batteries   use   an intercalated 

lithium compound as    one    electrode    material,     

compared     to the metallic lithium used in a non-

rechargeable lithium battery. Lithium-ion batteries 

are common rechargeable batteries for portable 

electronics, with a high energy density, no memory 

effect (other than LFP cells) and low self-discharge. 
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LIBs are  also growing in popularity for military, 

battery electric vehicle and aerospace applications. 

Lithium-ion batteries can be a safety hazard since 

they contain a flammable electrolyte and may 

become pressurized if they become damaged. A 

battery cell charged too quickly could cause a short 

circuit, leading to explosions and fires. Because of 

these risks, testing standards are more stringent than 

those for acid- electrolyte batteries, requiring both a 

broader range of test conditions and additional 

battery-specific tests, and there are shipping 

limitations imposed by safety regulators. There  

have  been  battery-related  recalls  by  some  

companies,  including   the   2016 Samsung Galaxy 

Note 7 recall for battery fires. 

Another problem can occur if a lithium-ion battery 

is damaged or crushed, or if a battery without 

overcharge protection is subjected to a higher 

electrical load than it can safely handle. 

Additionally, an external short circuit can trigger 

the batteries to explode. 

Research areas for lithium-ion batteries include life 

extension, energy density, safety, cost reduction, 

and charging speed, among others. Research has 

also been under way 

 

Fig 8:Li-Ion Battery 

 

for aqueous lithium-ion batteries, which have 

demonstrated fewer potential safety hazards due to 

their use of non-flammable electrolytes. 

Many times, there is need to step up or step down 

DC voltages. The circuits for stepping up or 

stepping down DC voltages are not simple as is the 

case with AC voltages. The level changing of DC 

voltages requires complex circuitry. These circuits 

are called DC to DC converters. The DC – DC 

converters are the electronic circuits which convert 

a constant DC voltage to a high voltage level or to a 

low voltage level. When a circuit increases the DC 

voltage to a higher level, it is called Boost 

Converter. When a circuit decreases DC voltage to 

a lower level, it is called buck converter. Since a 

boost converter converts the DC voltage to the 

higher voltage level, it is also known as a step-up 

converter. For boosting the voltage signal a 

regulator circuit is required which can step up the 

input voltage signal. 

Fig 9: Dc-Dc Stepup Converter Module 

  

Most of the electronic gadgets like smart phones, 

tablets work on 5V DC. However, for general 

purpose use, 3.7 V batteries are quite common. 

These batteries can be used to power up 5V devices 

using a boost converter circuit. In this electronics 

project, the voltage from 3.7 V Li-ion battery is 

boosted to 5V DC. The end of discharge voltage of 

Li-ion battery can be assumed 3.5 V so this circuit 

will convert the minimum input voltage of 3.5 V to 

5V level. A maximum current of 500 mA can be 

drawn by this boost converter. 

 

 SRD=05VDC - 5V SPDT RELAY 

 

The Single Pole Double Throw SPDT relay is quite 

useful in certain applications because of its internal 

configuration. It has one common terminal and 2 

contacts in 2 different configurations: one can be 

Normally Closed and the other one is opened or it 

can be Normally Open and the other one closed. So 

basically you can see the SPDT relay as a way of 

switching between 2 circuits: when there is no 

voltage applied to the coil one circuit “receives” 

current, the other one doesn’t and when the coil gets 

energized the opposite is happening. 
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Fig 10: SPDT Relay 

 

 

 

Fig 11: SPDT Switch 

 

 

SP and DP refer to single pole and double pole, ST 

and DT refer to single throw and double throw. 

Pole refers to the number of circuits controlled by  

the switch: SP switches control only one electrical 

circuit. DP switches control two independent 

circuits (and act like two identical switches that are 

mechanically linked). Do not confuse „pole‟ with 
„terminal‟. The DPST switch, for example, has four 

terminals, but it is a DP, not a 4P switch. Throw 

refers to the extreme position of the actuator: ST 

switches close a circuit at only one position. The 

other position of the handle is Off. DT switches 

close a circuit in the Up position, as well as the 

Down position (On-On). A DT switch can also have 

a center position (frequently On-Off- On). Single 

pole/throw and double pole/throw switches are by 

far the most common switches, but triple and 

quadruple configurations are also available. They 

are commonly denoted 3PST, 3PDT, 4PDT, etc. 

 

III   SOFTWARE DEVELOPMENT  

 
A  Arduino Ide 

The first time you run the Arduino software, it will 

automatically create a directory for your 

sketchbook. You can view or change the location of  

the sketchbook location from with the Preferences 

dialog. The source code for the IDE is released 

under the GNU General Public License, version 

The Arduino IDE supports the languages C and 

C++ using special rules of code structuring. The 

Arduino IDE supplies a software library from the 

Wiring project, which provides many common 

input and output procedures. User-written code only 

requires two basic functions, for starting the sketch 

and the main program loop, that are compiled and 

linked with a program stub main() into an 

executable cyclic executive program with the GNU 

tool chain, also included with the IDE distribution. 

The Arduino IDE employs the program avrdude to 

convert the executable code into a text file in 

hexadecimal encoding that is loaded into the 

Arduino board by a loader program in the board's 

firmware. 

 
B Uploading 

Before uploading your sketch, you need to select 

the correct items from the Tools > Board and Tools 

> Port menus. The boards are described below. On 

the Mac, the serial port is probably something like 

/dev/tty.usbmodem241 (for an Uno or Mega2560 or 

Leonardo) or /dev/tty.usbserial-1B1 (for a 

Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board 

connected with a Key span USB-to-Serial adapter). 

On Windows, it's probably COM1 or COM2 (for a 

serial board) or COM4, COM5, COM7, or higher 

(for a USB board) - to find out, you look for USB 

serial device in the ports section of the Windows 

Device Manager. On Linux, it should be 

/dev/ttyACMx , /dev/ttyUSBx or similar. Once 

you've selected the correct serial port and board, 

press the upload button in the toolbar or select the 

Upload item from the Sketch menu. Current 

Arduino boards will reset automatically and begin 

the upload. With older boards (pre-Diecimila) that 

lack auto-reset, you'll need to press the reset button 

on the board just before starting the upload. On 

most boards, you'll see the RX and TX LEDs blink 

as the sketch is uploaded. The Arduino Software 

(IDE) will display a message when the upload is 

complete, or show an error. When you upload a 

sketch, you're using the Arduino bootloader, a small 

program that has been loaded on to the 

microcontroller on your board. It allows you to 

upload code without using any additional hardware. 

The bootloader is active for a few seconds when the 

board resets; then it starts whichever sketch was 
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most recently uploaded to the microcontroller. The 

bootloader will blink the on-board (pin 13) LED 

when it starts (i.e. when the board resets). 

C  Serial Monitor 

This displays serial sent from the Arduino or 

Genuino board over USB or serial connector. To 

send data to the board, enter text and click on the 

"send" button or press enter. Choose the baud rate 

from the drop-down menu that matches the rate 

passed to Serial.begin in your sketch. Note that on 

Windows, Mac or Linux the board will reset (it will 

rerun your sketch) when you connect with the serial 

monitor. Please note that the Serial Monitor does 

not process control characters; if your sketch needs 

a complete management of the serial 

communication with control characters, you can use 

an external terminal program and connect it to the 

COM port assigned to your Arduino board.You can 

also talk to the board from Processing, Flash, 

MaxMSP, etc (see the interfacing page for details). 

D  Features of The Project: 

 

 Fully digital control: No need for passive analog 

components. 

 Modular design: Every sub-circuit is a pre-

defined easy to use module. 

 Output frequency: Available range from 0Hz to 

10MHz. 

 Simple control: Single rotary encoder with 

built-in push button. 

 Li-ion battery for portable use, with external 

charging ability. 

 AC and DC coupling for output waveform. 

 LCD Brightness control for energy consumption 

reduction. 

 Battery charge indicator. 

 Digital amplitude control. 

 Three available waveforms: Sine, triangle and 

square. 

 

IV   RESULT 

Images of different waveforms like Sine waveform, 

Triangular waveform and Square waveforms are 

taken. The measures like Amplitude, Frequency, 

Brightness, Out Coupling is observed. 

 

 

 
Fig 13: Sine Wave Output 

 

 
Fig 14: Triangular Wave Output 

 

 
 

Fig 15: Amplitude of The Square Waveform 

 

 
 

Fig 16: Frequency Of The Waveform In Mhz 
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V   CONCLUSION 

This low cost Portable Function generator using 

Arduino is fully digital control. It has Modular 

design. It operates in output frequency of available 

range from 0Hz to 10MHz.It has simple control 

Single rotary encoder with built-in push button. It 

uses Li-ion battery for portable use, with external 

charging ability. It has LCD Brightness control for 

energy consumption reduction, Battery charge 

indicator, Digital amplitude control. Three available 

waveforms in this system are Sine, triangle and 

square wave forms. 
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